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1. УВОД 

 
На основу Закона о посебним условима за евидентирање и упис права на 

непокретностима, Агенција за просторно планирање и урбанизам Републике Србије (у 

даљем тексту Агенција), уз подршку Републичког геодетског завода (у даљем тексту РГЗ), 

спроводи поступак прикупљања, обраде и стандардизације просторних података који 

се односе на зоне јавне намене, зоне посебне намене, јавну и приватну својину, као и 

начин коришћења земљишта. 

У циљу ефикасне примене одредаба овог закона, Агенција и РГЗ су припремили 

техничко упутство које дефинише начин израде и доставе кључних векторских подлога 

које се односе првенствено на зоне накнаде и зоне јавне намене, зоне посебне намене, 

јавну и приватну својину, у сврху израде дигиталног зонинг плана у прописаном ГИС 

формату. 

Поступак евидентирања непокретности, у смислу евидентирања врсте намене и начина 

коришћења земљишта на предметној непокретности, вршиће се преко дигиталне ГИС 

платформе коју су успоставили РГЗ и Агенција. 

Дигитална ГИС платформа представља јединствени информациони систем који 

обједињује све потребне податке за: 

● мапирање и разграничење врста јавних намена, посебних намена, јавне и 

приватне својине на непокретностима; 

● дефинисање граница зона накнада градова и општина; 

● утврђивање начина коришћења земљишта на нивоу катастарске парцеле, 

односно јединствене функционалне целине; 

● мапирање и разграничење зона накнаде -зона за утврђивање доприноса за 

уређивање грађевинског земљишта (У даљем тексту: Зоне накнаде). 

1.1 Сврха документа 

Овим упутством се утврђује јединствени технички поступак припреме и достављања 

просторних података који се односе на зоне јавне намене, зоне посебне намене и зоне 

накнада, ради уједначене примене Закона о посебним условима за евидентирање и 

упис права на непокретностима. 

Циљ документа је да пружи стручну и техничку подршку јединицама локалне 

самоуправе у процесу припреме ГИС подлога, кроз: 

● јасно дефинисане кораке за израду и доставу података; 
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● уједначену структуру и садржај векторских података; и 

● обезбеђивање техничке исправности и употребљивости података за увоз у 

дигиталну ГИС платформу. 

1.2 Основне информације и структура Упутства 

Ово упутство примењује се за све јединице локалне самоуправе које припремају и 

достављају векторске геопросторне податке о зонама јавне намене, зонама посебне 

намене и зонама накнада, у циљу њиховог уноса у дигиталну ГИС платформу у 

прописаном ГИС формату. 

Упутство не замењује званичну документацију софтверских решења као што су AutoCAD 

или QGIS. Ово упутство, садржи додатна појашњења одредаба Закона о посебним 

условима за евидентирање и упис права на непокретностима и ближе ће утврдити 

начине припреме фајлова тражених у одговарајућем стандардизованом ГИС формату, 

начин припреме фајлова за извоз из векторског софтверског програма у којем је 

графички прилог – технички документ претходно припремљен, као и даље смернице 

које се односе на начин коришћења дигиталне ГИС платформе, односно начина 

достављања тражених података Агенцији. 

1.3 Очекивани резултат поступка 

Резултат примене овог упутства су стандардизовани сетови векторских података који 

представљају јединствену основу за израду и ажурирање дигиталних Зонинг планова, 

као и за евидентирање права на непокретностима у складу са законом. 

Припремљени подаци садрже јасно дефинисане полигоне зона јавне намене, зона 

посебне намене и зона накнада, као и прописану структуру атрибута која омогућава 

њихову идентификацију и тематску анализу. 

Тако припремљени подаци достављају се у прописаном ГИС формату Агенцији ради 

увоза у централну дигиталну ГИС платформу и даљег коришћења у оквиру званичних 

евиденција и јавних регистара. 

1.4 Надлежности 

Агенција је одговорна за дефинисање стандарда, достављање QGIS шаблона, контролу 

и увоз података у дигиталну ГИС платформу. 

Јединице локалне самоуправе (ЈЛС) припремају, попуњавају и достављају просторне 

податке у складу са овим упутством и прописаним ГИС форматом. 
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1.5 Садржај и структура документа 

У наредним поглављима овог упутства детаљно су описани поступци и техничке 

смернице који обухватају: 

● утврђивање основних појмова и класификација које се односе на врсте јавне 

намене, посебне намене, јавне и приватне својине на непокретностима и зоне 

накнада; 

● припрему документације у векторском формату (DWG); 

● извоз података из векторског програма у одговарајући ГИС формат; 

● учитавање и рад са подацима у програму QGIS; 

● припрему ГИС формата и додељивање атрибута; 

● коришћење дигиталне ГИС платформе – основне функције и начин уноса 

података; 

● унос векторских  полигона и доделу атрибута у оквиру платформе; и 

● унос атрибута  кроз дигиталну ГИС платформу у случају да постоји само 

геометрија. 

2. ЗОНЕ ЈАВНЕ НАМЕНЕ, ПРИВАТНЕ И ЈАВНЕ СВОЈИНЕ 
У складу са одредбама Закона о посебним условима за евидентирање и упис права на 

непокретностима, поступак евидентирања обухвата утврђивање граница земљишта 

јавне и приватне својине, као и начина коришћења непокретности у оквиру зона јавне 

намене. 

Ово поглавље даје основна појашњења појмова и критеријума који се примењују 

приликом припреме података за дигиталну ГИС платформу. 

На територији једне непокретности могу постојати различити облици својине и начина 

коришћења земљишта. Земљиште може бити у својини физичког или правног лица, као 

и у јавној својини Републике Србије, јединице локалне самоуправе или другог јавног 

субјекта. 

У зависности од правног режима и положаја објеката, поступак евидентирања спроводи 

се на следећи начин: 
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Евиденција у јавној својини 

● Објекти изграђени на земљишту у јавној својини, предвиђеном за изградњу 

објеката јавне намене у обавезној јавној својини, евидентирају се и уписују у 

корист Републике Србије. 

● Овај поступак се примењује на објекте који се налазе у границама: 

o у првој зони заштите природног добра, зони заштите културног добра од 

великог значаја и културног добра од изузетног значаја, у другој зони 

заштите природног добра изграђени на земљишту у јавној својини, 

објекти уписани у Листу светске културне баштине или објекти који су 

изграђени на самом културном добру, на јавном водном добру, у 

пружном појасу, у непосредној зони санитарне заштите водоизворишта, 

као и у појасу експропријације државног пута IA – аутопутеви и IM реда – 

брзе саобраћајнице  

Евиденција у приватној својини 

● За објекте изграђене на земљишту у приватној својини подносиоца пријаве који 

су предвиђени за изградњу објеката јавне намене у обавезној јавној својини, али 

нису приведени планској намени, врши се упис права својине подносиоца 

пријаве и евидентира се да објекат нема право на исплату тржишне вредности 

објекта, већ искључиво на исплату грађевинске вредности објекта. 

Посебни случајеви 

● За објекте изграђене у другој зони заштите природног добра, као и за објекте који 

мањим делом заузимају површину заштитног појаса јавног пута или се 

делимично налазе у заштићеној околини војних објеката, врши се упис права 

својине подносиоца пријаве, уз претходну сагласност имаоца јавних овлашћења. 

● За објекте изграђене у другој зони заштите природног добра који су изграђени 

на земљишту јавне намене у јавној својини, уписује се право својине у корист 

Републике Србије. 

● За објекте изграђене на земљишту јавне намене у осталим облицима својине, 

евидентира се да је објекат изграђен у складу са смерницама из важећег 

планског документа и врши се упис права својине подносиоца пријаве, уз 

претходну сагласност имаоца јавних овлашћења. 
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3. ЗОНИНГ ПЛАН 
Дигитални Зонинг план је мапа  зона  јавних намена, посебних намена и зона накнада 

и служи за потребе утврђивања могућности евидентирања и уписа права на 

непокретности у смислу овог Закона. Дигитални Зонинг план није плански документ и 

њиме се не уређују документи просторног и урбанистичког планирања, већ 

представља обједињени скуп формираних полигона наведених намена, зона накнаде 

и ауторитативних слојева који могу бити подржани техничком и планском 

документацијом. 

Јединица локалне самоуправе врши припрему дигиталних векторских података у 

прописаном формату – стандардизовани ГИС формат (.shp, .geojson, .gml, .gpkg) – и 

доставља их Агенцији у циљу уноса података у дигиталну ГИС платформу. 

3.1 О дигиталном Зонинг плану 

За успешно спровођење овог Закона, дефинисан је дигитални Зонинг план као скуп 

докумената и података у одговарајућем стандардизованом векторском ГИС формату, 

који садржи полигоне - границе зона јавне намене, зона посебне намене (војни 

комплекси, експлоатациона поља минералних сировина и зоне режима заштите) и зона 

накнада. За јавне намене које су приказане линијским ознакама и симболима у 

планским документима, уносиће се прилагођени полигони површина који одговарају 

фактичком коришћењу. 

За потребе израде дигиталног Зонинг плана, могу се ангажовати стручна лица која 

обављају стручне послове просторног планирања, урбанизма, геодезије и уређења 

простора.  

У складу са одредбама члана 4. став 1. тачка 6. Закона о посебним условима за 

евидентирање и упис права на непокретности (У даљем тексту: Закон), дигитални Зонинг 

план обухвата сет графичких прилога припремљених у стандардизованом ГИС формату 

са обухватом следећих зона: 

● Зоне јавне намене у свим облицима својине су зоне намене које у складу са 

одредбама овог Закона, као и других закона којима се ближе дефинише овај 

термин и које могу бити у свим облицима својине. У складу са наведеним, ово се 

односи на објекте јавне намене у осталим облицима начина коришћења (објекти 

државне управе и локалне самоуправе, објекти здравствене заштите, образовне 

установе и објекти дечје заштите, објекти социјалне заштите, објекти културе, 

објекти за спорт и рекреацију, комунални објекти и др.) 

● Зоне јавне намене у обавезној јавној својини  у складу са одредбама члана 4. 

став 1. тачка 12. овог Закона су зоне намене објеката инфраструктуре – коридори 

- саобраћајнице државни путеви  IА и IM реда, државни путеви IIА и II Б реда, 
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општински и локални путеви, градске саобраћајнице – саобраћајнице у 

границама грађевинског подручја јединице локалне самоуправе, железничке 

пруге - пружни појас, објекти енергетике – далеководи, продуктоводи, 

топловоди, нафтоводи, гасоводи и др. Зоне посебних намена су војни комплекси, 

експлоатациона поља минералних сировина, зоне рекултивације и санације, као 

и друге специјалне намене. Такође, за потребе спровођења овог закона у зоне 

посебне намене уврштене су и површине у којима се спроводе режими заштите 

и коришћења простора прописани посебним прописима: 

 

○ режими заштите I и II степена заштићеног природног добра; 

○ режими заштите културног добра од изузетног значаја и културног добра 

од великог значаја и њихове заштићене околине, објекти уписани у Листу 

светске културне баштине или изграђени на самом културном добру; 

○ зоне непосредне и уже санитарне заштите изворишта за снабдевање 

водом; 

○ заштитни појасеви линијских инфраструктурних коридора (заштитини 

појас јавног пута, пружни и инфраструктурни појас железничке пруге и 

заштитни пружни појас, заштитни појас хидротехничке, 

електроенергетске и термотехничке инфраструктуре, заштитни појас 

гасовода, продуктовода и нафтовода); 

○ зоне забране градње у складу са прописима Директората за цивилно 

ваздухопловство); 

○ режим потпуне урбанистичке заштите за архитектонско - урбанистичке 

целине; 

○ режими заштите око објеката војске ( зоне забрањене, ограничене и 

контролисане градње); 

○ заштитни простор око експлоатационог поља минералних сировина ради 

могућег проширења резерви и ресурса; и 

○ подручја са ризиком од технолошког и хемијског удеса. 

 Зоне накнаде, у складу са одредбама члана 4. став 1. тачка 5. овог Закона, садрже 

све зоне у границама територије јединице локалне самоуправе за коју је Одлуком 

Скупштине јединице локалне самоуправе одређена висина доприноса за уређивање 

грађевинског земљишта и за коју је одговарајућим актом Скупштине јединице локалне 

самоуправе дефинисана граница појединачних зона накнаде у графичком векторском 

формату. 
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 Зонинг план, садржи искључиво полигоне у дигиталном векторском 

припремљеном ГИС формату. За потребе припреме дигиталног Зонинг плана, односно 

полигона за спровођење и примену овог закона, плански документи су правно-техничка 

подршка у реализацији јединствених подлога.  

 Сви документи ближе дефинисани у овом поглављу, припремаће се искључиво у 

одговарајућем стандардизованом ГИС векторском формату и исти се достављају 

Агенцији на начин ближе уређен овим законом у року од 45 дана од дана ступања на 

снагу овог Закона, а о чему ће све јединице локалне самоуправе, односно имаоци јавних 

овлашћења бити обавештени у даљем тексту овог упутства. Сви графички прилози, 

претходно подлежу обавезној припреми полигона у одговарајућем софтверском 

векторском програму, након чега се исти извозе у одговарајући ГИС векторски формат, 

чиме се остварује основ за увоз таквог документа у Дигиталну ГИС платформу. У случају 

да Агенција изврши контролу припремљеног и достављеног материјала и утврди 

техничке неисправности приложених података, исти ће бити враћени на усклађивање и 

техничку исправку (Поглавље 11.2 овог упутства). 

3.2  Садржај дигиталног Зонинг плана који припремају јединице 

локалне самоуправе 

 У складу са одредбама овог Закона, све јединице локалне самоуправе Агенцији 

достављају дигитални Зонинг план, као један обједињен фајл са полигоном, 

дигитализацијом следећег садржаја: 

 

1. Зоне јавних намена у обавезној јавној својини - објекти инфраструктуре – 

коридори - саобраћајнице државни путеви  IА и IM реда, државни путеви IIА и II 

Б реда, општински и локални путеви, градске саобраћајнице – саобраћајнице у 

границама грађевинског подручја јединице локалне самоуправе, железничке 

пруге  - пружни појас, објекти енергетике – далеководи, продуктоводи, 

топловоди, нафтоводи, гасоводи и др, паркови, отворене јавне површине, јавне 

зелене површине и др.; 

2. Зоне јавних намена и објеката на јавном земљишту у свим облицима својине и 

у осталом начину коришћења - објекти државне управе и локалне самоуправе, 

објекти здравствене заштите, образовне установе и објекти дечије заштите, 

објекти социјалне заштите, објекти културе, објекти за спорт и рекреацију, 

комунални објекти – (објекти у функцији управљања отпадом, снабдевања 

водом за пиће, пречишћавања и одвођења атмосферских и отпадних вода; 

производње, дистрибуције и снабдевања топлотном енергијом; градског и 

приградског превоза путника, управљање гробљима и сахрањивање; погребне 

делатности; управљања јавним паркиралиштима, обезбеђивања јавног 

осветљења; управљања пијацама; одржавања улица и путева; одржавања 
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чистоће на површинама јавне намене, одржавања јавних зелених површина, 

димничарских услуга и делатности зоохигијене) и др. 

3. Зоне посебне намене – зоне заштите непокретних културних добара, зона 

заштићених природних добара, зоне непосредне санитарне заштите 

водоизворишта и акумулација, границе водног земљишта, зоне специјалних 

намена, заштитних појаса инфраструктурних коридора - државних путева другог 

реда, општинских путева  и др.; 

4. Зоне накнаде – зоне за утврђивање доприноса за уређивање грађевинског 

земљишта. 

3.3 . Геопросторни подаци Дигиталне ГИС платформе које не 

припремају јединице локалне самоуправе – ауторитативни 

слојеви дигиталног Зонинг плана 

Агенција, у складу са својим надлежностима ближе одређеним у одредбама овог 

Закона и Закона о планирању и изградњи, припрема дигитални Зонинг план који 

садржи: 

 

1. Појасе експропријације државних путева првог реда, појаса експропријације и 

пружних појаса железничке инфраструктуре, електро-енергетских и објеката 

енергетике и то: далековода, гасовода, топловода, продуктовода као и осталих 

објеката инфраструктуре из надлежности Агенције за просторно планирање и 

урбанизам, односно објеката ближе утврђених важећим планским документом 

(Просторним планом подручја посебне намене) са дефинисаним зонама 

експропријације и детаљном урбанистичком разрадом. Наведено се односи на све 

објекте планиране јавне намене за коју се утврђује обавезна јавна својина и на зоне 

јавне намене у свим облицима коришћења, зоне посебне намене и објекте изведене 

из важећих планских и других техничких докумената за које су у складу са одредбама 

члана 47. Закона о планирању и изградњи Агенција за просторно планирање и 

урбанизам Републике Србије, односно Министарство грађевинарства, саобраћаја и 

инфраструктуре одређени као носиоци израде; 

 

2. Ауторитативни подаци у складу са одредбама овог Закона су званични подаци које 

производи и одржава орган, институција или правна лица са законским или 

формалним мандатом, а који се признају као једини веродостојан и референтан 

извор за одређену област (геодетско-катастарског информационог система, 

Националне инфраструктуре геопросторних података, правосудно-информационог 

система, података о непокретностима које прикупља и обрађује Републички завод 

за статистику, локална пореска администрација, ЈП „Пошта Србије” и др.). 
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3.4 Смернице за израду дигиталног Зонинг планова: 

● предмет доставе нису плански документи – просторни и урбанистички планови 

и документи за директно спровођење, већ фокусиране информације које се 

односе на предефинисане зоне јавне и посебне намене и зоне накнада;  

● плански документи, као и други графички прилози које поседују Имаоци 

јавних овлашћења са дефинисаним зонама из свог делокруга надлежности, 

користе се као техничка подршка у припреми ових полигона; 

● за припрему геометрије полигона могу се користи одговарајуће софтверско 

решење по избору (AutoCAD, AutoCAD 3D map view, ArcGIS, QGIS, MapInfo и 

други); 

● за финалну доставу користи се стандардизовани QGIS шаблон који обезбеђује 

јединствену структуру података или Дигитална ГИС платформа услед 

немогућности припреме података кроз QGIS шаблон. Стандардизовани QGIS 

шаблон је већ припремљени фајл који ће бити доступан на интернет страници 

(линк је приложен у Поглављу 12.1) . Исти је могуће преузети и користити у сврхе 

припреме векторских података у одговарајућем координатном систему; 

● јединице локалне самоуправе не врше накнадну трансформацију координата 

података, већ достављају податке у изворном координатном систему у којем је 

израђен плански документ из кога су преузети подаци, копирајући захтеване 

податке у QGIS шаблон или назначавајући координатни систем приликом 

доставе .SHP фајлова уколико исти није доступан .PRJ фајл, као и у случају да 

исти није одговарајући за унос у Дигиталну ГИС платформу; 

● сви подаци морају бити векторског формата, достављени као полигони, са 

прописаном структуром атрибута (зона јавне намене, зона посебне намене и 

зона накнаде) израђени у ГИС-у; 

● именовање фајлова, слојева и поља врши се у складу са стандардом именовања 

Агенције; Сваки достављени документ, уколико се ЈЛС одлучи да не користи QGIS 

шаблон, припремате по узору на следеће примере: 

Zone_ namena_Ljubovija_09-062/Zone_naknade_Ljubovija_09-062;  

● припремљени подаци морају бити технички исправни, тополошки валидни, 

потпуни и усклађени са овим упутством; 

● Свака јединица локалне самоуправе, уколико финалну предају не ради кроз 

припремљени QGIS шаблон, доставља највише један слој – лејер за зоне 

намене и један слој – лејер  за зоне накнада уз попуњен стандардизовани XLSX 

документ са износом накнада за сваку од зона; 

● Сви полигони зона намена у оквиру једног фајла морају се налазити у истом 

слоју у случају доставе у .GPKG или другом формату. Ово се односи на све 
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припремљене полигоне изведених зона намена из графичког, односно 

векторског техничког документа. 

● Сви полигони зона накнада у оквиру једног фајла морају се налазити у истом 

слоју у случају доставе у .GPKG или другом формату. Уз слој зона накнада 

обавезно се испоручује попуњен стандардизовани XLSX документ са износом 

накнада за сваку од зона 

4. АПЛИКАЦИЈА ЗА еСЕРТИФИКАЦИЈУ ЛИЦА 

ОДРЕЂЕНИХ ЗА ИЗРАДУ ДИГИТАЛНОГ ЗОНИНГ 

ПЛАНА: 

4.1 О апликацији: 

Јединствена веб апликација за електронску едукацију и сертификацију лица одређених 

од стране јединица локалних самоуправа за унос података у дигиталну ГИС платформу 

са циљем израде дигиталног Зонинг плана на основу Закона о посебним условима за 

евидентирање и упис права на непокретности. 

Апликација за еСертификацију садржи обавезне еОбуке и јединствену базу знања која 

овлашћеним лицима из јединица локалних самоуправа омогућава да се сертификују и 

успешно спроведу израду дигиталног зонинг плана (зона).   

4.2 Регистрација и пријава корисника: 

У циљу ефикасног поступања у складу са одредбама овог Закона, а у циљу додатног 

појашњења о начину припреме и достављања тражене документације – података који 

су саставни елемент дигиталног зонинг плана, све јединице локалне самоуправе 

достављају Агенцији на имејл zoningplan@appurs.gov.rs списак лица која ће бити 

овлашћена и одговорна за валидност, веродостојност и тачност припремљених 

докумената за наведене поступке и то: припрему тражених докумената дигиталног 

зонинг плана, као и остале материјале по потреби са обавезним контакт подацима: име, 

презиме, назив јединице локалне самоуправе, матични број јединице локалне 

самоуправе, број телефона,  и јединствену имејл адресу.  

Овлашћена лица испред јединица локалних самоуправа на имејл који су послали 

АППУРС-у добијају инструкције за логовање на апликацију за еСертификацију и упутство 

за коришћење апликације.  

Апликацији се приступа отварањем линка https://svojnasvome.eobuke.rs/ и уносом 

јединственог корисничког имена и лозинке.  

https://svojnasvome.eobuke.rs/
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4.3 Садржај обука за еСертификацију: 

Након успешне пријаве на апликацију за еСертификацију овлашћена лица су у обавези 

да похађају еОбуку како би стекла Сертификат за израду дигиталног Зонинг плана на 

основу Закона о посебним условима за евидентирање и упис права на непокретности. 

У оквиру еОбуке „Упутство за израду дигиталног Зонинг плана на основу Закона о 

посебним условима за евидентирање и упис права на непокретности“ овлашћена лица 

пролазе следеће едукативне лекције: 

1. Свој на своме – кратке смернице и рокови 

2. Свој на своме – о Закону и његовој примени 

3. Дигитални Зонинг план 

4. Опште смернице за припрему дигиталног Зонинг плана 

5. Регистрација на Платформу за пренос података дигиталног Зонинг плана 

6. Дигитална ГИС платформа 

7. Припрема ГИС података за израду дигиталног Зонинг плана 

8. Припрема ГИС података из AutoCAD-a и AutoCAD 3D Map view 

9. Припрема ГИС података из QGIS-a 

10. Израда полигона користећи дигиталну ГИС платформу 

11. Додела атрибута за потребе дигиталног Зонинг плана 

12. Додела атрибута из QGIS-а 

13. Додела атрибута у дигиталној ГИС платформи 

14. Зоне накнаде 

 

4.4 База знања: 

Након успешно завршених еОбука овлашћено лице из јединице локалне самоуправе је 

Сертификовано за израду дигиталног Зонинг плана на основу Закона о посебним 

условима за евидентирање и упис права на непокретности и добија приступ посебном 

делу апликације са базом знања. 

У оквиру базе знања овлашћено лице има приступ додатним материјалима који служе 

као подршка у процесу израде дигиталног Зонинг плана (мапа): едукативни видео 

садржаји, битни линкови, документи и описи. 

4.5 АИ четбот 

Активирањем статуса сертификованог овлашћеног лица у апликацији, кориснику постаје 

доступан АИ четбот — интелигентни дигитални асистент који обезбеђује континуирану 

и персонализовану стручну подршку у свакодневном раду. 
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АИ четбот је интегрисан као део система подршке и омогућава овлашћеним лицима да: 

● постављају питања у вези са израдом зонинг планова и тумачењем релевантних 

процедура; 

● добијају брзе и прецизне одговоре засноване на важећим законским и 

подзаконским актима; 

● претражују и приступају документима, видео материјалима и упутствима из базе 

знања; 

● користе предлоге, шаблоне и примере добре праксе у складу са актуелним 

стандардима; 

● буду благовремено обавештени о изменама прописа и новим смерницама у 

систему. 

AI четбот функционише као дигитални саветник доступан 24 часа дневно, који 

доприноси повећању ефикасности, сигурности и уједначености у примени процедура 

израде зонинг планова. 

5. ПРИСТУП ПЛАТФОРМИ ЗА РАЗМЕНУ МАТЕРИЈАЛА 

(QNAP) 
Платформа QNAP користи се за безбедну размену докумената између институција и 

јединица локалне самоуправе. Преко ове платформе, ЈЛС ће моћи да преузимају 

припремљене материјале (шаблоне, обрасце, табеле и другу документацију) и да 

достављају своје попуњене документе у назначене фасцикле.  

Линк ка платформи за размену материјала је: https://q1.rgz.gov.rs/cgi-bin/, док ће истој 

бити могуће приступити и на насловној страници: https://svojnasvome.eobuke.rs/ 

(Поглавље 4.2 овог упутства) на насловној страници која ће се појавити након извршене 

пријаве корисника, на позиционираном банеру са горње десне стране: Платформа за 

размену материјала (QNAP). 

5.1 Како се приступа систему 

Сваки корисник добија индивидуални налог који креира администратор QNAP система. 

 За креирање налога неопходно је: 

● доставити званичну адресу електронске поште, 

● поседовати паметни уређај (паметни телефон или таблет) за активацију 

двофакторске аутентификације. 

У складу са врло строгом безбедносном политиком, систем аутоматски закључава налог 

трајно након три неуспела покушаја пријаве. У том случају, поновно активирање налога 

врши искључиво администратор уз верификацију идентитета корисника. 

https://q1.rgz.gov.rs/cgi-bin/
https://svojnasvome.eobuke.rs/
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Двофакторска аутентификација (2FA): 

Сви корисници су у обавези да активирају двофакторску аутентификацију при првом 

логовању. 

Поступак укључује: 

1. Пријаву са корисничким именом и лозинком. 

2. Избор опције „Enable 2-Step Verification“. 

3. Скенирање QR кода у мобилној апликацији (QNAP NAS Account) 

4. Унос шестоцифреног кода приликом сваке будуће пријаве. 

На овај начин, чак и у случају компромитације лозинке, систем остаје заштићен јер је 

потребан и физички приступ уређају корисника. 

5.2 Безбедносни принципи 

● QNAP се редовно ажурира у складу са безбедносним процедурама. 

● Приступ је ограничен на дефинисане кориснике и мрежне опсеге. 

● Сви покушаји пријаве и активности се бележе у системским логовима. 

● Злоупотреба налога, дељење приступних података или 2FA кодова се сматра 

тешким безбедносним прекршајем. 

5.3 Где се налазе материјали 

Након пријаве, отвара се интерфејс апликације. Корисник бира фолдер File Station 6. 

 У њему се налазе: 

● фолдер са материјалима за преузимање; 

● фолдер за доставу припремљених датотека. 

 

5.4 Како се ради у систему 

За преузимање материјала довољно је означити жељену датотеку или фолдер и 

одабрати Download. 

За доставу докумената користи се опција Upload у фасцикли за доставу. 

Препоручује се да се не мењају називи фасцикли и да се користе већ формирани називи, 

у складу са Поглављем 3.4 овог упутства. 

5.5 Како се ради у систему 

Систем је обезбеђен и свака ЈЛС има свој налог и свој радни простор. 

Уколико дође до проблема са приступом, биће потребно обратити се администратору 

ради поновног активирања налога. 
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6. ДИГИТАЛНА ГИС ПЛАТФОРМА 
Дигитална ГИС платформа представља информациони систем који на једном месту 

обједињује, чува, приказује и омогућава управљање и анализу ауторитативних 

геопросторних података из регистара надлежних органа и организација, укључујући и 

геопросторне податке достављене од стране ЈЛС-ова у поступка припреме дигиталног 

Зонинг плана, који је предмет ове обуке и пратећег Упутства.  

Имајући у виду да је стандардизовани ГИС векторски формат обавезан за припрему 

података који се достављају од стране ЈЛС-ова, у наредним обукама објашњени су 

„корак-по-корак“ начини припреме полигона зона намене и зона накнада у дигиталном 

векторском формату,  који су део дигиталног Зонинг плана потребног за спровођење и 

поступање по одредбама овог закона. 

6.1 Регистрација и пријава корисника на Дигиталну ГИС 

платформу 

У циљу ефикасног праћења и примене  овог Упутства, све јединице локалне самоуправе 

достављају Агенцији на имејл адресу zoningplan@appurs.gov.rs списак лица која ће бити 

овлашћени корисници Дигиталне ГИС платформе, одговорни за валидност, 

веродостојност и тачност припремљених података за израду мапе дигиталног Зонинг 

плана, као и припрему осталих материјала по потреби, са обавезним контакт подацима:  

● Име; 

● Презиме; 

● број телефона; и 

● имејл адреса. 

Агенција уз подршку РГЗ, дужна је да обезбеди корисничке налоге и приступ Дигиталној 

ГИС платформи.  

По достављању контакт података, Агенција ће на основу достављених имејл адреса  

извршити верификацију и регистрацију корисничких налога за лица која су доставила 

исправне контакт податке и истима доставити податке за пријаву на Дигиталну ГИС 

платформу. 

6.2 Начин приступања Дигиталној ГИС платформи      

Након достављања података Агенцији о лицима одговорним за унос, припрему и 

тачност података за мапу дигиталног Зонинг плана на страни ЈЛС-а, овлашћени 

корисници на интернет страници www.mapp.rgz.gov.rs/Apps/ могу да приступе 

Дигиталној ГИС платформи. 

 

http://www.mapp.rgz.gov.rs/Apps/
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Коришћењем инструкција добијених од Агенције путем мејла за приступ Платформи, 

корисник потврђује свој налог и дефинише корисничку лозинку. Након ове операције 

кориснички налог је успешно регистрован. Линк ка Дигиталној ГИС платформи доступан 

је и путем банера, односно иконице која се налази са десне стране на Платформи за 

обуку и сертификацију лица, под називом Дигитална ГИС платформа (Слика 1). 

 

Слика 1: Дигитална ГИС платформа - пријава корисника 

6.3 Садржај и функционалности Дигиталне ГИС платформе 

Након успешног логовања са корисничким именом и лозинком, корисник приступа 

Дигиталној ГИС платформи која на почетној страни садржи две картице за два сета 

података дигиталне мапе Зонинг плана — Зоне накнаде и Зоне намене (Слика 2). 
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Слика 2: Дигитална ГИС платформа - Изглед картица      

Одабиром одговарајуће картице, кориснику је омогућен преглед претходно 

припремљених или учитаних полигона зона накнаде или зона намене, у чијој позадини 

се налазе подлоге са подацима Дигиталног катастарског плана (ДКП), дигиталних 

ортофото снимака (ДОФ) и других ауторитативних података за подлоге. Поред 

наведених података подлога, на Дигиталној ГИС платформи доступни су и други 

ауторитативни подаци, као што су подаци Регистра просторних јединица (границе 

катастарских општина, насељених места, градова, општина, управних округа, итд.), 

подаци Регистра објеката (подаци о неевидентираним објектима у Катастру 

непокретности), подаци Дигиталног катастарског плана (подаци о евидентираним 

објектима, границама катастарских парцела и катастарских парцела у јавној својини 

Републике Србије), као и подаци зона јавних добара и подручја под режимом заштите 

природних и културних добара, и др. Број и разноврсност доступног садржаја на 

Дигиталној ГИС платформи ће временом расти како подлоге за публиковање на 

Платформи буду припремане, као и како се потребе корисника Платформе буду 

мењале. 

Конкретно, одабиром картице Зоне намене корисник улази у окружење Дигиталне ГИС 

платформе у које су, поред претходно наведених подлога, унети и ауторитативни 

подаци из различитих националних регистара, који су претходно припремљени за 

публиковање у одговарајућем векторском ГИС формату. Између осталих, ту су подаци 

траса инфраструктурних коридора, за чију припрему су коришћени графички прилози 

важећих просторних планова подручја посебне намене. На пример, публиковани су 

подаци инфраструктурног коридора Просторног плана подручја посебне намене „Вожд 

Карађорђе“, где су полигони трасе из графичког прилога овог Плана у CAD формату 

извезени у ГИС векторски формат ради њихове припреме, а потом извезени у .shp/gpkg 
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формату ради њиховог публиковања на Дигиталној ГИС платформи. Након што су 

подаци полигона трасе припремљени у траженом стандардизованом ГИС векторском 

формату и достављени Агенцији, исти су публиковани на Дигиталној ГИС платформи. 

Поред наведених лејера са подацима различитих подлога и других података из 

националних регистара са ауторитативним подацима, картице Зоне намене и Зоне 

накнаде садрже лејер (слој) са подацима зона намене и зона накнаде које креира ЈЛС у 

току припреме тражених ГИС података за израду дигиталног Зонинг плана на основу 

овог Упутства. 

Слика 3: Дигитална ГИС платформа - Изглед мапе 

Тако, поред уноса полигона припремљених у AutoCAD-у и QGIS-у на Дигиталну ГИС 

платформу, Платформа омогућава именованим корисницима ЈЛС унос нових полигона 

зона накнаде и зона намене директно на овој Платформи применом методе 

исцртавања, уз коришћење доступних података подлога и геометрије постојећих 

граничних тачака катастарских парцела, као и креирање нових аналитичких тачака тамо 

где је то потребно. Овај метод креирања геометрије зона намене и зона накнаде, као и 

методе припреме геометрије полигона зона намене и зона накнаде у QGIS-у и AutoCAD-

у и њихов унос у Дигиталну ГИС платформу, детаљно су описани у наредним 

поглављима  овог упутства. 

Без обзира на начин припреме тражених ГИС података за мапу дигиталног Зонинг плана 

(увоз или ручни унос геометрије полигона), Дигитална ГИС платформа омогућава 

прилагођавање полигона фактичком коришћењу зона намене и зона накнаде, као и 

доделу атрибута за сваки полигон зоне. 
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Пре објашњења поступка припреме полигона зона намене и зона накнаде на Дигиталној 

ГИС платформи, што ће бити тема у наредним поглављима и лекцијама, 

функционалности и алати саме Дигиталне ГИС платформе биће представљени у наставку 

овог поглавља. 

 

Слика 4: Дигитална ГИС платформа - Приказ елемената интерфејса 

У горњем десном углу Дигиталне ГИС платформе налази се отворен прозор са пољем 

„Претрага парцела“, у које се може укуцати број и подброј тражене катастарске парцеле 

са навођењем катастарске општине ради брзог проналажења и лоцирања на исту на 

подручју ЈЛС-а. 

 

Коришћењем доступних алата за преглед (иконица за видљивост и смернице), корисник 

може да се лоцира на одређену зону намене ЈЛС-а, као и на зоне намене припремљене 

од стране Агенције, као јединствене полигоне са атрибутима. 

 

У функционалном погледу, Дигитална ГИС платформа садржи алате за мерење и 

утврђивање површине, као и алат за преглед и управљање подацима зона намене и 

зона накнаде на Дигиталној ГИС платформи. Коришћењем овог алата, који ће бити 

детаљније објашњен у наредним лекцијама, могу се прегледати постојећи подаци за 

сваки полигон зоне намене, као што је податак о врсти намене зоне, датуму креирања 

и имену корисника који је креирао зону, и дугме за проналажење зоне, где се 

једноставним кликом на “лупу” корисник лоцира на полигон изабране зоне намене. 
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7. ГЕНЕРАЛНА СТРУКТУРА ПРИПРЕМЕ ГИС 

ПОДАТАКА ЗА ИЗРАДУ ДИГИТАЛНОГ ЗОНИНГ ПЛАНА 

– АНАЛИЗА ОДГОВАРАЈУЋЕГ МЕТОДА ПРИПРЕМЕ 

ГЕОМЕТРИЈЕ 

7.1 Уводне препоруке и одабир најбоље стратегије: 

Резултат примене припремљеног Упутства су стандардизовани сетови векторских 

података који представљају јединствену основу за израду, ажурирање и међусобно 

повезивање информација за потребе мапе дигиталног зонинг плана. 

Да би се обезбедила доследна и тачна припрема података, јединице локалне 

самоуправе треба да, пре почетка рада, утврде у ком облику им је тренутно доступна 

релевантна документација и да одаберу одговарајући начин припреме тражених 

стандардизованих сетова векторских података за израду дигиталног Зонинг плана. 

У зависности од облика, тј. нивоа дигитализације релевантне документације, разликују 

се следећи формати података и начини њихове припреме: 

1. Векторски подаци у DWG формату 

● Подаци релевантне документације постоје у AutoCAD DWG формату. 

● Препоручује се њихова конверзија у ГИС формат (.shp, .gpkg), и припрема 

геометрије полигона и унос атрибута у QGIS шаблону. 

● Алтернативно, могуће је припремити геометрију полигона у ГИС формату а 

затим их увести у Дигиталну ГИС платформу ради стандардизованог уноса 

атрибута 

2. Векторски подаци у ГИС формату 

● Подаци релевантне документације су већ у стандардном ГИС формату (.shp, 

.gpkg, .gml, .geojson). 

● Потребно је користити доступни QGIS шаблон ради уноса атрибута у складу са 

дефинисаним стандардом Агенције. 

● Алтернативно, могућа је припремити геометрију полигона у ГИС формату а 

затим их увести у Дигиталну ГИС платформу ради стандардизованог уноса 

атрибута. 
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3. Аналогни формат 

● Подаци релевантне документације постоје искључиво у папирној форми 

(планови, прилози, скице). 

● Поступак подразумева скенирање, геореференцирање и векторизацију 

релевантне документације.. 

● Уколико такав поступак није изводљив у задатим роковима и са расположивим 

капацитетима, омогућен је директан унос тражених података за дигитални 

Зонинг план на Дигиталној ГИС платформи, који подразумева ручно 

исцртавање полигона Зона намене и Зона накнаде коришћењем доступних 

ортофото снимака или катастарских подлога без могућности коришћења 

додатних слојева података и подлога којима располаже ЈЛС, а који би помогли 

у исцртавању. 

4. Геореференцирани растерски подаци 

● Релевантна документација постоји у дигиталном облику (нпр. .tif) и већ је 

геореференцирана. 

● Препоручује се ручна векторизација полигона Зона намене и Зона накнаде у 

QGIS-у или неком другом ГИС алату на основу података геореференцираног 

растера, а затим унос атрибута полигона коришћењем стандардизованог QGIS 

шаблона или Дигиталне ГИС платформе. 

● Цртање полигона и унос атрибута могу се спровести на Дигиталној ГИС 

платформи, без увоза геореференцираних података као подлоге, чиме се овај 

поступак изједначава са начином припреме релевантне документације у 

аналогном формату. 

5. Недостатак расположивих података 

● Ако релевантна документација не постоји ни у аналогном ни у дигиталном 

формату, омогућено је да се тражени сетови векторских података припреме 

директно на Дигиталној ГИС платформи, ручним исцртавањем полигона Зона 

намене и Зона накнаде коришћењем доступних ортофото снимака или 

катастарских подлога, као и уносом атрибута за исцртане зоне на Дигиталној ГИС 

платформи, без могућности коришћења додатних слојева података и подлога 

којима располаже ЈЛС, а који би помогли у исцртавању. 
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Формати 

релевантне 

документације 

Припрема и достава геометрије Унос и стандардизација 

атрибута 

1. DWG (AutoCAD) 

формат 

Конверзија DWG у SHP/GPKG  

Стандардизација података кроз 

QGIS. (Поглавље 8.1) 

Унос и стандардизација 

атрибута у QGIS шаблону 

(Поглавље 9.1) или на 

Дигиталној ГИС 

платформи (Поглавље 

9.2). 

2. Постојећи ГИС 

формат (.shp, .gpkg, 

.gml, .geojson) 

Постојећа геометрија без измена, 

уз проверу координатног система 

и топологије (Поглавље 8.2). 

Унос/проверa атрибута у 

QGIS шаблону (Поглавље 

9.1) или на Дигиталној 

ГИС платформи 

(Поглавље 9.2). 

3. Аналогни 
формати 

Скен + геореференцирање + 
векторизација у QGIS-у (није 
дефинисано упутством), или 
ручно исцртавање полигона на 
Дигиталној ГИС платформи без 
импорта додатних подлога (није 
предмет овог упутства) 

 

4. 
Геореференцирани 
растерски подаци 

Самостална векторизација у QGIS-
у или ручно исцртавање на 
Дигиталној ГИС платформи без 
импорта додатних подлога – 
Није обухваћено упутством. (није 
предмет овог упутства) 

 

5. Недостатак 

расположивих 

података 

Геометрија се креира ручно на 

Дигиталној ГИС платформи 

(цртање полигона преко 

ортофото или катастарске 

подлоге) (Поглавље 8.3). 

Атрибути се уносе ручно 

кроз Дигиталну ГИС 

платформу током 

креирања полигона 

(Поглавље 9.2). 

Табела 1: Брза контрола 

7.2  Одабир одговарајућег метода припреме података за израду 

дигиталног Зонинг плана  

У наставку овог упутства, биће представљен програм еОбуке за припрему података 

сходно формату доступне релевантне документације и исти ће бити доступан на 

едукативним видео материјалима, текстуалним садржајима и описима, као и другој 

документацији (упутство). Напомињемо да, у зависности од метода по којем је 
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припремљен и израђен важећи плански документ, односно други технички документ у 

одговарајућем векторском софтверском формату, такав материјал планског документа 

(графички прилог) можете искористи у сврхе припреме векторских полигона потребних 

за израду дигиталног Зонинг плана ЈЛС-а. Ово Упутство даје смернице и инструкције за 

неколико понуђених метода захваљујући којима ћете најлакше, најефикасније и 

најтачније припремити тражене полигоне дигиталног Зонинг плана у одговарајућем 

стандардизованом ГИС формату.  

● Под претпоставком да је плански документ припремљен у AutoCAD 

одговарајућем софтверу, користећи софтвер: AutoCAD / AutoCAD Map 3D и алате 

које вам ови векторски софтвери нуде, извршићете корекције графичког прилога 

планског документа, односно другог техничког документа на тај начин да ће бити 

јасно дефинисани векторски полигони. У случају да корекцију оваквог документа 

не вршите на лицу места користећи софтвере AutoCAD / AutoCAD Map 3D, биће 

могуће одређене корекције – отклањање техничких грешки у преносу података;  

● Под претпоставком да већ имате припремљен стандардизовани ГИС формат 

техничког документа а потребни су вам делови тог документа које ћете 

векторисати и обликовати, извести у форми векторског полигона, користићете 

неке од алата у било ком ГИС софтверском програму (пример софтвера који ћемо 

користити у овом упутству у сврхе обуке је QGIS); и 

● Под претпоставком да немате претходно припремљен векторски полигон у 

векторском формату, у наставку овог упутства добићете инструкције о могућим 

методама израде/исцртавања, припреме и векторизације траженог полигона 

ручним исцртавањем, користећи Дигиталну ГИС платформу.  

Ова обука, укључује следећи план и програм: 

1. Припрема векторских полигона користећи векторске податке у DWG формату: 

AutoCAD / AutoCAD Map 3D; 

1.1. Исцртавање полигона на већ изведеним подлогама графичког прилога: 

Полигони који су већ исцртани или нису исцртани на начин погодан за 

веродостојан извоз у одговарајући ГИС формат – Припрема полигона 

коришћењем команди (Hatch/Hatchgenerateboundaries), односно векторизација 

полигона исцртавањем новог полигона преко постојећег цртежа; 

1.2. Прочишћавање полигона и цртежа уклањањем додатних слојева у AutoCAD 

софтверу, брисање додатних линија и површина – нејасноћа и недефинисаних 

елемената у цртежу који отежавају извоз и идентификацију векторских 

полигона, односно онемогућују издвајање идеалних изведби из овог софтвера; 

2. Припрема полигона коришћењем команди у ГИС формату; 

2.1. Вршење корекција на већ извезеном векторском полигону користећи команду 

(Edit Geometry); 
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2.2. Додељивање симбологије, координатног система и осталих елемената у циљу 

корекције при извожењу полигона на „лицу места“; 

3. Аналогна припрема: Векторизација у припремљеном стандардизованом ГИС 

полигону користећи алате QGIS-а; 

3.1. Исцртавање по узору на границе дефинисане у растерском документу користећи 

алате QGIS-а; 

4. Самостално исцртавање и векторизација користећи алате QGIS-а; 

5. Исцртавање геометрије и векторизације полигона директно на Дигиталној ГИС 

платформи; 

 

На основу наведеног, у овом упутству ће вам бити ближе представљене следеће 

методе извоза одговарајућег, стандардизованог ГИС формата (документа): 

 

1. Извоз (Export) припремљених полигона из AutoCAD Map 3D векторског софтвера у 

одговарајући ГИС формат – вршење извоза линије, односно полигона из одабраних 

слојева у DWG документу; 

2. Директан увоз (Import) отвореног документа у DWG формату у QGIS-у и то: 

2.1. (Import/Export) команда у QGIS-у отвореног документа у DWG формат; 

2.2. (Import) векторског лејера – слоја који је већ претходно извезен у одговарајућем 

ГИС формату (.shp, .gpkg, .GeoJson) 

2.3. Директан увоз (Import) векторског лејера – слоја превлачењем фајла у QGIS; 

3. Припрема полигона исцртавањем геометрије по узору на растерски технички 

документ користећи алате QGIS-а и извоз истих у QGIS-у; 

4. Исцртавање полигона и одређивање аналитичких тачки исцртавањем геометрије на 

лицу места, на Дигиталној ГИС платформи; 

У смислу накнадног вршења корекција извезеног векторског полигона, биће 

представљена два метода: 

1. Вршење корекција на већ извезеном векторском полигону користећи команду (Edit 

Geometry) (овај метод ће бити ближе представљен и у начину припреме векторског 

полигона користећи алате у QGIS-у) (Поглавље: 8.2) 

2. Вршење корекција на исцртаном векторском полигону којем сте у Дигиталној ГИС 

платформи „на лицу места“ доделили аналитичке тачке. 

Поред наведеног, у овом упутству ће бити ближе појашњен начин додељивања 

атрибута на векторизованом полигону који сте претходно припремили на један од 

одговарајућих начина: 

1. Додељивање атрибута у користећи алате QGIS софтвера 

2. Додељивање атрибута користећи алате Дигиталне ГИС платформе и то: 

2.1. У току исцртавања геометрије и векторизације полигона; 

2.2. Приликом вршења измене полигона; 
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Посебне смернице у овом упутству се односе на додељивање координатног 

система у QGIS-у. Потребно је сваки ГИС формат векторског цртежа приказати у 

одговарајућем координатном систему (Поглавље 8.2): 

1. EPSG:6316 (ГКGK7) 

2. EPSG:8678 (ГКGK6) 

3. EPSG:8682 (УТМ 34Н) (у складу са законом) 

Ово упутство, посебно ће указати на појединости припреме овог документа, као 

и дати посебне смернице и напомене: 

● Начин припреме ГИС формата: Све намене површина и зоне накнаде се могу 

припремати на следећи начин: 

o Појединачно: извоз слој по слој, додељивање атрибута и осталих 

података, а затим спајање свих извезених ГИС формата у јединствени ГИС 

фајл – један ГИС фајл за „Зоне намене“, односно један ГИС фајл за „Зоне 

накнаде“; (Ово се односи на метод припреме и векторизације полигона у 

AutoCAD-у, односно AutoCAD Map 3D софтверу а затим извоз ГИС 

формата у QGIS-у); 

o Обједињено: Извоз слојева (лејера) у случају да користите метод извоза 

слојева из DWG фајла без претходног издвајања слојева у AutoCAD 

софтверу, користећи (Import/Export) команду, односно користећи (Add 

Vector layer) команду у QGIS-у на основу отвореног DWG документа; 

Посебна напомена: Сви документи који чине саставни елемент дигиталног 

Зонинг плана, детаљно су описани у Поглављу 3.2 овог упутства. 

8. ПРИПРЕМА ГЕОМЕТРИЈЕ ПОЛИГОНА 
Ово поглавље описује поступке припреме просторних података у прописаним ГИС 

форматима који представљају основу за даљу обраду и увоз у дигиталну ГИС платформу. 

У зависности од тога којим софтверским алатом јединица локалне самоуправе (ЈЛС) 

располаже, могу се применити различити приступи: 

● припрема података у AutoCAD / AutoCAD Map 3D софтверу или 

● припрема полигона у било ком ГИС алату и стандардизација у QGIS-у. 
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8.1. ПРИПРЕМА ГИС СЛОЈЕВА ИЗ СОФТВЕРСКОГ РЕШЕЊА AutoCAD / 

AutoCAD Map 3D 

8.1.1. Зашто овај поступак? 

Овај метод је погодан за обрађиваче који су навикли да раде у CAD окружењу и већ 

поседују DWG планове у којима су дефинисани полигони зона јавне намене, зоне 

накнада и зоне посебне намене. 

Циљ је да се постојећи DWG садржај припреми тако да буде технички исправан и 

употребљив у ГИС окружењу. 

8.1.2. Важне напомене 

● Софтверско решење мора подржавати опцију извоза (експорта)  у .SHP 

● Сви објекти који представљају зоне морају бити у затвореној полилинији 

(полигон). 

● Слојеви који су предмет извоза (експорта) морају бити очишћени од анотација, 

легенди, цртаних симбола и шрафура, односно свих елемената који нису 

затворене полилиније (полигони). 

● Уколико су објекти исцртани као линије или CAD блокови, потребно их је 

претворити у полигоне пре извоза: 

o Команда: BOUNDARY или MAPCLEAN (опција Create closed polylines). 

o Блокови се морају EXPLODE пре извоза. 

8.1.3. Припрема DWG фајла: 

1. Отворити DWG датотеку у AutoCAD. 

→ Мени: File → Open → [изаберите DWG фајл] (Слика 1) 
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Слика 5: Увоз DWG фајла у AutoCAD/AutoCAD 3D map 

2. Омогућити само потребне слојеве (Layers): 

o У Layer Properties Manager-у обележити све слојеве, а затим искључити све 

непотребне слојеве. 

o Поновним уласком у Layer Properties Manager, оставити видљивим само 

оне који садрже полигоне зона јавне и посебне намене или зона накнада. 

(Слика 6) 

o Извршити проверу свих полигона који су вам потребни – Извршити 

пречишћавање графичких делова техничког документа: Обрисати 

непотребне површине, непотребне линије, текст, симболе, издвојити 

делове површина које желите да прикажете читко и др. 

 

Слика 6: Припрема слојева у AutoCAD/AutoCAD 3D map 
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3. У случају да тражене зоне – површине нису у формату затвореног полигона већ 

су исцртани користећи команду: Line, потребно је извршити једну од следећих 

метода: 

o Исцртати полигон користећи команду Polyline, а затим користећи контуре 

постојећих граница исцртати, а затим затворити жељени векторски 

полигон коришћењем команди Pedit, а затим Close; 

o Припремити будући полигон који је исцртан линијски тако да му 

затворите све отворене делове његових граница, а затим испунити 

линијски затворену површину користећи команду: Hatch, након чега ћете 

одабрати све површине за које сте извршили овај метод и користити 

команду Hatchgenerateboundaries, чиме ће се на обележеним испуњеним 

површинама дефинисати границе полигона. Након што обришете 

испуњене површине, ваши новонастали полигони ће се као ивични-

гранични делови блока, односно зоне задржати, након чега ће исти моћи 

да се извезу у одговарајући ГИС формат; 

 
Слика 7: Попуњавање површина у AutoCAD/AutoCAD 3D map 

 

o У случају да су већ исцртане линије које имају значајно већу дебљину у 

односу на дефинисане дебљине у опису слоја - лејера, што је најчешће 

пример за трасе инфраструктурних коридора, односно објеката 

инфраструктуре, потребно је користити команду: Pedit, након чега ћете 

одабрати команду Width из падајућег менија, приликом чега ће вам се 

појавити одређена димензија са могућношћу измене исте. У том случају 

након што упишете број 0 у понуђеном пољу, кликом на Enter смањићете 

дебљину ваше линије на дебљину дефинисану у опису вашег слоја – 

лејера. 
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Након што сте припремили појединачне слојеве, исте можете извести у одговарајући 

ГИС формат. Важно је поново нагласити да овај метод даје значајну подршку приликом 

припреме векторских полигона приказаних у различитим слојевима DWG фајла, које 

ћете у QGIS-у након додељивања атрибута (Поглавље 8.2.3., тачка 8) извршити спајање 

свих изведених ГИС формата у један јединствени ГИС формат, користећи команду: 

Merge. 

8.1.4. Поступак извоза у ГИС формат 

4. Отворити DWG датотеку у AutoCAD Map 3D. 

→ Мени: File → Open → [изаберите DWG фајл] 

5. Омогућити само потребне слојеве (Layers): 

o У Layer Properties Manager-у искључити све непотребне слојеве. 

o Оставити видљивим само оне који садрже полигоне зона јавне намене 

зоне посебне намене или зона накнада. 

6. Проверити да су сви полигони затворени: 

o Команда: PEDIT → Close 

o Алтернативно: MAPCLEAN → Detect Dangles / Create Closed Polygons 

7. Покренути извоз у ГИС формат: 

o Отворити мени: Output → Map Export → Other GIS Formats… 

o У прозору Export Location одабрати фолдер за чување. 

o У пољу Files of type изабрати: 

▪  ESRI Shapefile (*.SHP) – препоручени формат, или 

▪  GeoPackage (*.GPKG) – ако је доступна подршка. 

o Кликнути OK. 

8. У прозору Export Dialog: (Слика 4) 

o Selection → изабрати Current Display (само видљиви објекти). 

o Options → под Object Type изабрати Polygon. 

o Layers → кликнути на икону са три тачке и изабрати само релевантне 

слојеве (може се користити CTRL+Click). 

o Потврдити избор кликом на OK и сачекати да се извоз заврши. 
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Слика 4: Извоз одабраних слојева у SHP формат 

5. Провера резултата у QGIS-у: 

1. Отворити QGIS и изабрати: Layer → Add Layer → Add Vector Layer… 

2. Изабрати извезени .shp фајл и кликнути Add → Close. 

3. Десни клик на слој → Zoom to Layer (проверити да је подручје видљиво). 

4. Десни клик → Properties → Information → проверити: 

o Geometry: Polygon или MultiPolygon, 

o CRS: један од следећих — EPSG:6316 (ГК7), EPSG:8678 (ГК6), EPSG:8682 

(UTM 34N). 

5. Ако се полигони не виде или су измештени, проверити CRS и поновити извоз 

ако је потребно. 

8.1.5. Очекивани резултати: 

● Један фајл са зонама намена у оквиру истог лејера 

● Један фајл са зонама накнада у оквиру истог лејера 

● Фајл се успешно отвара у QGIS-у без грешке 

● Сви објекти су полигоналне геометрије 

● Позиција и координатни систем су исправни 

● SHP фајл је спреман за унос атрибута или за достављање Агенцији 
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8.2. ПРИПРЕМА ГИС СЛОЈЕВА ИЗ СОФТВЕРСКОГ РЕШЕЊА QGIS 

8.2.1. Зашто овај поступак? 

Овај метод је погодан за јединице локалних самоуправе који поседују документе 

просторног и урбанистичког планирања у DWG/DXF формату, али желе да изврше 

финалну припрему, чишћење и стандардизацију података директно у ГИС окружењу. 

Имајући у виду да се ради о бесплатном и робусном софтверском решењу који је у 

широкој продукцијској примени, овај начин се посебно препоручује у случајевима када 

ЈЛС не располаже одговарајућим софтверским лиценцама комерцијалних софтвера. 

QGIS подржава директан увоз CAD формата и омогућава извоз у стандардне ГИС 

формате као што су .SHP и .GPKG без потребе за додатним алатима. 

Предност овог приступа је већа контрола над геометријом и координатним системом, и 

могућност увоза додатних подлога. 

Главни изазови односе на квалитет улазног DWG фајла и то што је потребно основно 

познавање рада у QGIS-у. 

ЈЛС за припрему геометрије полигона могу користити и друга ГИС решења уколико 

располажу одговарајућим лиценцама и имају већу фамилијарност са њима у односу на 

QGIS. 

8.2.2. Важне напомене пре увоза DWG фајла (веза са Поглављем 8.1.4) 

● Сви објекти који представљају зоне морају бити затворени полигони (polylines). 

● Слојеви који су предмет  извоза (експорта) морају бити очишћени од анотација, 

легенди, цртаних симбола и шрафура, односно свих елемената који нису 

полигони. 

● Уколико су објекти исцртани као линије или блокови, потребно их је претворити 

у полигоне пре извоза: 

o Команда: BOUNDARY или MAPCLEAN (опција Create closed polylines). 

o Блокови се морају EXPLODE пре извоза. 

8.2.3. Поступак увоза DWG/DXF у QGIS (Слика 5) 

1. Отворити QGIS и креирати нови пројекат (Project → New Project) или покренути 

шаблон QGIS пројекат. 

2. У горњем менију изабрати: 

Project → Import/Export → Import Layers from DWG/DXF… 
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Слика 5: Увоз DWG документа у QGIS-у 

 

3. У прозору Import from DWG/DXF: (Слика 6) 

o У пољу Source Drawing кликнути на икону са три тачке (…) 

→ одабрати DWG/DXF датотеку. 

o Након учитавања, приказаће се доступни слојеви. 

o Уколико се слојеви не прикажу аутоматски, кликнути на Load Layers. 
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Слика 6: Прозор увоза DWG у QGIS-у 

 

4. Означити само слојеве који садрже полигоне зона (границе јавне намене, зоне 

накнада). 

→Потврдити избор кликом на OK.  

→ Слојеви ће се додати у Layers Panel као груписани векторски слој. 

5. Проверити геометрију: 

o Десни клик на слој → Properties → Information → Geometry: 

→ мора бити Polygon или MultiPolygon. 

6. У случају да су извезене линије планираних полигона, односно у случају да нису 

извезени затворени полигони у QGIS-у већ су дефинисане појединачне линије, 

могуће је применити једну од следећих метода: 

o У случају да је предмет извоза објекат инфраструктуре – саобраћајница, 

инфраструктурни коридор, објекат енергетике – водови и сл. а који су у форми 

линије са дефинисаном дебљином у опису слоја у DWG фајлу, исти је потребно 

припремити као полигон на један од следећих начина: 

▪  Дефинисање ширине објекта инфраструктуре – користећи команду Offset у 

софтверском решењу AutoCAD, односно AutoCAD 3D Map, поставити 

граничне линије које ћете затворити на један од начина који су већ 

дефинисани у претходном делу овог поглавља. Након успешног извоза 

(Export/Import) у QGIS-у, кликом на поље у адресном бару – Vector, а затим 

у падајућем менију кликнути на Geometry Tools. Одабиром команде: Line to 

Polyline одабраћете у одељку Parameters жељени слој – Input layer, а након 
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тога у доњем десном углу отвореног прозора кликнути на Run, након чега ће 

се затворене лине трансформисати у полигон; 

▪  У случају да постоји јединствена линија као једини векторски податак за вашу 

зону намене, извршићете извоз те векторске линије у одговарајући ГИС 

формат користећи поступак из Поглавља 8.1.4. овог упутства, након чега ћете 

исти извести у QGIS, оставити увезени слој – лејер као обележен и у адресном 

бару – Vector, у падајућем менију одабрати команду Geoprocessing Tools и у 

следећем делу падајућег менија одабрати команду Buffer, након чега ће се 

отворити нови прозор и након чега ћете имати могућност да у одељку 

Parameters одаберете жељени слој – Input layer, а затим дефинисати ширину 

линије коју желите да претворите у полигон: Distance. У одељку End cap style,  

одабраћете у падајућем менију Flat, након чега ћете у доњем десном углу 

овог прозора кликом на Run, дефинисати ширину линије, односно линија и 

тако направити јединствени полигон. Након што се у левом делу вашег 

екрана QGIS софтвера у одељку Layers, појавио нови слој: Buffer, у десном 

углу bar-а тог лејера налази се иконица Save. Кликом на ову иконицу, 

одабраћете директоријум у којем ћете сачувати ваш новонастали слој – лејер 

и доделити му назив, као и одговарајући ГИС формат. 

7. Проверити координатни систем (CRS): 

o Ако није препознат, десни клик на слој → Set Layer CRS… 

→ изабрати одговарајући координатни систем:  

▪  EPSG:6316 (ГК7) 

▪  EPSG:8678 (ГК6) 

▪  EPSG:8682 (УТМ34Н). 

o У случају да координатни систем није препознат, нити се ваш сачувани 

резултат у стандардизованом ГИС формату не налази нити у једном од 

одабраних стандардних координатних система, потребно је обратити се 

обрађивачу тог техничког документа и пронаћи одговарајући 

координатни систем; 

o У случају да је векторски технички документ припремљен из више делова, 

односно склопљен из више појединачних делова који су припремани у 

различитим координатним системима, потребно је извршити корекцију 

самог техничког документа. 

8. Одабрати слојеве – лејере које ћете спојити у један јединствени ГИС формат 

користећи команду Merge: (Слика 7, Слика 7.1, Слика 7.2, Слика 7.3, Слика 7.4, 

Слика 7.5).Након што унесете жељене слојеве - ГИС формате (layers) у QGIS, са 
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ваше десне стране ће бити доступан прозор: Processing Toolbox. У делу где је 

могуће извршити брзу претрагу, потребно је уписати Merge након чега се отвара 

нови прозор - Vector General - Merge Vector Layers. 

 

Слика 7: Спајање SHP слојева 

У делу Input layers, кликнућете на иконицу са три тачке и из доступног списка свих 

слојева, одабрати жељене за спајање (Merge). 

 
Слика 7.1: Спајање SHP слојева 
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Избор слојева за обједињавање у један се врши одабиром жељених слојева тренутно 

учитаних у QGIS. 

 
Слика 7.2 Спајање SHP слојева 

 

Након завршеног избора корисник бира опцију OK. 

У делу: Destination CRS, одабраћете координатни систем у којем желите сачувати 

новонастали спојени слој (layer). Уколико се улазни подаци налазе у ГК6 или ГК7 

препорука за излазни координатни систем је EPSG:8682. Избором овог излазног 

координатног система у кроз процедуру спајања биће извршена уједно и 

трансформација геометрије из ГК6 или ГК7 у УТМ пројекцију. 

 

 

Слика 7.3 Спајање SHP слојева 



 

39 
 

У одељку Merged кликом на иконицу са три тачкице, отвориће вам се падајући мени где 

ћете одабиром на Save to GeoPackage одабрати директоријум у којем желите да га 

сачувате, одабрати назив фајла и одговарајући ГИС формат фајла и тако сачувати исти. 

 
Слика 7.4 Спајање SHP слојева 

 

Након одабира путање излазног фајла у следећем прозору унесите интуитиван назив 

будућег спојеног слоја. 

 
Слика 7.5 Спајање SHP слојева 

 

Након извршених конфигурација, кликнућете на OK, а затим кликнути на Run. 
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8.2.4. Очекивани резултати: 

● Један фајл са зонама намена у оквиру истог лејера 

● Један фајл са зонама накнада у оквиру истог лејера 

● Фајл се успешно отвара у QGIS-у без грешке 

● Сви објекти су полигоналне геометрије 

● Позиција и координатни систем су исправни 

● GPKG фајл спреман за унос атрибута или достављање Агенцији 

8.3 КРЕИРАЊЕ НОВОГ ПОЛИГОНА (ОПЦИЈА ДОДАВАЊА И 

УРЕЂИВАЊА ПОДАТАКА) У ДИГИТАЛНОЈ ГИС ПЛАТФОРМИ 

Опција додавања и уређивања података директно кроз Дигиталну ГИС платформу 

представља механизам који су РГЗ и Агенција обезбедили за јединице локалне 

самоуправе (ЈЛС) које немају сопствене техничке или кадровске капацитете да изврше 

припрему и прикупљање података у QGIS-у или CAD окружењу. 

Ограничења и препоруке 

Главно ограничење овог приступа односи се на немогућност учитавања локалних 

подлога (DWG, SHP, растер и сл.) као помоћи при исцртавању, као и на одређена 

ограничења у цртању на Дигиталној ГИС платформи у односу на десктоп решења (нпр. 

QGIS). 

Због тога се овај приступ препоручује само у случајевима када прикупљање података 

није изводљиво у QGIS-у или неком другом ГИС алату. 

1. Пријавите се на Дигиталну ГИС платформу као професионални корисник. 

2. Изаберите једну од понуђених опција за унос „Зоне намене“ или „Зоне накнада“. 

Поступак је идентичан за оба слоја, па ће у наставку бити обрађен само слој Зоне 

намена. (Слика 8) 
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Слика 8: Дигитална ГИС платформа 

 

3. Након учитавања апликације Кликните на опцију „Додавање полигона јавне 

намене“. (Слика 9) 

 

Слика 9: Дигитална ГИС платформа – Радна подлога 
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4. Унесите основне атрибуте пре цртања: 

o Врста намене– изабрати вредност са листе понуђених опција; 

 
Слика 10: Додавање полигона јавне намене 

 

5. Након уноса атрибута, изаберите опцију „Креирај геометрију“. 

6. На ортофото или катастарској подлози ручно исцртајте полигон левим 

једноструким кликом миша на појединачне тачке (вертикале/ломне тачке 

границе). 

 
Слика 11: Изглед припремљеног полигона 
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7. Завршите цртање двоструким левим кликом миша и потврдите унос кликом на 

опцију „Save“. 

 
Слика 12: Чување полигона 

 

8. Након успешног додавања полигона, форма за унос новог полигона је аутоматски 

активна и можете наставити унос следећег као од корака 4. Уколико желите да 

одустанете форму можете угасити на дугме X у горњем десном углу. 

9. СТАНДАРДИЗАЦИЈА АТРИБУТА  

9.1. СТАНДАРДИЗАЦИЈА АТРИБУТА ИЗ СОФТВЕРСКОГ РЕШЕЊА 

QGIS 

Поступак доделе атрибута се спроводи у циљу обезбеђивања јединствене, 

стандардизоване структуре података у оквиру Дигиталне ГИС платформе. 

Сви подаци који се увозе на Дигиталну ГИС платформу морају бити припремљени у 

складу са QGIS шаблоном доступним на порталу за размену материјала QNAP, који 

садржи унапред дефинисане слојеве геопросторних података са одговарајућом 

структуром атрибута за зоне намене и зоне накнаде 

Јединице локалне самоуправе користе овај шаблон за унос атрибута, односно њихових 

вредности, за  претходно припремљену геометрију полигона зона намене и зона 

накнаде објашњено детаљно у претходним поглављем овог Упутства. 

● Поред припремљеног QGIS шаблона, Агенција за слој података зона накнада 

доставља и пратећи Excel (.xlsx) фајл на QNAP порталу, намењен за унос износа накнада 
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по зонама, који ЈЛС попуњава и доставља ради стандардизованог уноса података о 

висини накнада на Дигиталној ГИС платформи. 

У поступку доделе атрибута, ЈЛС за полигоне зона намене уносе вредност атрибута за 

поље ВРСТА НАМЕНЕ избором једне од предефинисаних вредности, о чему је било речи 

у Лекцији број 2 (Свој на своме - О Закону и његовој примени), у коме су ближе 

дефинисане и појашњене врсте намена и врсте својине 

Предефинисане вредности атрибута за поље ВРСТЕ НАМЕНЕ су:  

● Јавна намена у обавезној јавној својини - уписана приватна својина 

● Јавна намена у обавезној јавној својини - уписана јавна својина 

● Јавна намена у свим облицима својине - уписана приватна својина 

● Јавна намена у свим облицима својине - уписана јавна својина 

● Посебне намене 

9.1.1 Структура и избор шаблона 

Агенција обезбеђује три QGIS шаблона, идентична по структури али различита по 

координатном систему (пројекцији) и броју ауторитативних подлога: 

● У случају да ЈЛС жели да ради са максималним бројем подлога и најажурнијим 

ауторитативним подацима користи се шаблон под називом 

Template_UTM34N_epsg8682.qgz 

● У случају да ЈЛС не жели да користи ажурне и ауторитативне подлоге или не жели 

самостално да врши трансформацију података, ЈЛС је дужна да изабере  шаблон 

са ознаком координатног система у ком је израђена геометрија полигона. 

Ознака шаблона Опис координатног 

система (пројекције) 

EPSG код 

Template_UTM34N_epsg8682.

qgz 

UTM зона 34N EPSG:8682 

Template_GK6_epsg8678.qgz Гаус-Кригер зона 6 EPSG:8678 

Template_GK7_epsg6316.qgz Гаус-Кригер зона 7 EPSG:6316 

Табела 2: Приказ шаблон пројеката 

9.1.2 Поступак рада  

Корак 1. Отварање шаблона 

1. Покренути QGIS. 

2. Из менија одабрати File → Open Project... 
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3. Изабрати шаблон који одговара координатном систему (нпр. 

Template_GK7.qgz). 

4. Након отварања шаблона, проверити у статусној линији да ли координатни 

систем дефинисан у Layer CRS одговара (EPSG код из табеле горе). 

 
Слика13: Изглед QGIS шаблона 

 

Корак 2. Увоз припремљене геометрије 

1. Из менија изабрати Layer → Add Layer → Add Vector Layer… 

2. Кликнути на Browse, изабрати .shp или .gpkg фајл припремљен у кораку 5.1 или 

5.2. 

3. Потврдити избор кликом на Add → Close. 

4. Проверити визуелно да се полигони поклапају са подлогом (ако постоји) и са 

координатним системом пројекта. 

Корак 3. Копирање полигона у слој шаблона 

1. У Layers панелу означити свој увезени слој. 

2. Отворити табелу атрибута (десни клик → Open Attribute Table). 

3. У табели атрибута означити све редове (Ctrl + A) и кликнути Copy Selected 

Features. 
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4. У Layers панелу активирати циљни слој (нпр. Zone_namene): 

o десни клик → Toggle Editing On, 

o затим Paste Features. 

5. Сачувати измене кликом на Save Edits. 

Корак 4. Унос вредности атрибута 

1. Отворити табелу атрибута циљног слоја (десни клик → Open Attribute Table). 

2. Укључити Edit mode (оловчица у горњем левом углу). 

3. У колони Врста намене одабрати вредност из понуђене листе ( ЈАВНА НАМЕНА 

У ОБАВЕЗНОЈ ЈАВНОЈ СВОЈИНИ - УПИСАНА ЈАВНА СВОЈИНА). 

4. Након попуњавања свих редова, кликнути Save Edits и затим искључити режим 

уређивања (Toggle Editing Off). 

Напомена: сва поља морају бити попуњена. Опциона поља нису предвиђена. 

Корак 5. Провера комплетности 

1. У табели атрибута проверити да у свим редовима постоје вредности за сва 

поља. 

2. Потврдити да број полигона у слоју одговара броју полигона у оригиналном 

фајлу (команда: Layer → Properties → Information → Feature Count). 

3. Сачувати пројекат (File → Save Project). 

Стандард за именовање је : jls_<naziv_jls>_projekcija_<crs>.qgz 

Предмет доставе је .qgz пројекат и фајл zoning_plan_epsgXXX.gpkg 

9.2 СТАНДАРДИЗАЦИЈА АТРИБУТА КРОЗ ДИГИТАЛНУ ГИС 

ПЛАТФОРМУ  

Опција додавања и уређивања података директно кроз Дигиталну ГИС платформу 

представља алтернативни механизам који су РГЗ и Агенција обезбедили за јединице 

локалне самоуправе (ЈЛС) које немају сопствене техничке или кадровске капацитете да 

изврше припрему и прикупљање података у QGIS-у или CAD окружењу. 

9.2.1 Измена и допуна атрибута (уколико је геометрија 

достављена као .SHP а недостају атрибути) 

1. Изаберите опцију за табеларни преглед свих унетих полигона на дигиталној ГИС  

платформи. 
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Слика 14: Слојеви јавних намена у Дигиталној ГИС платформи 

 

2. Идентификујте полигон чије атрибуте желите да измените/допуните. 

3. Левим кликом миша, у табели кликните на идентификовани полигон. 

4. У отвореном дијалогу (прозору) избором из падајуће листе измените или унесите 

вредност атрибута. 

 
Слика 15: Измена геометрије и додељених података Врста намене у Дигиталној ГИС 

платформи 
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5. Потврдом на дугме „Сачувај атрибуте“ можете сачувати измене. У случају 

погрешног избора, кликом на опцију „Одустани“ је могуће одустати од измена. 

9.2.2 Очекивани резултати 

По завршетку рада, сваки полигон мора имати: 

● затворену и тополошки исправну геометрију; 

● попуњене атрибуте Врста намене; и 

● јасно видљив положај у односу на ортофото и катастарску подлогу. 

 

Сви унети подаци чувају се аутоматски у систему, а Агенција врши преглед и валидацију 

унетих полигона у складу са дефинисаним техничким стандардом. 

10. ЗОНЕ НАКНАДЕ 

10.1 Табела за унос цена зона накнаде 

Уз QGIS шаблон пројекат за слој зона накнаде, Агенција доставља и пратећи Excel 
(.xlsx) фајл намењен за унос података о висини накнада по подношењу пријаве 
захтева. 

Фајл садржи пет обавезних колона: 

● Шифра зоне (id); 

● Назив зоне (naziv_zone); 

● Износ комерцијала (РСД/m²) (iznos_komercijala); 

● Износ становање (РСД/m²) (iznos_stanovanje); и 

● Износ за производне и привредне делатности (РСД/m²) 

(iznos_proizvidnja_privreda). 
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Слика 15: Шифарник Зона накнаде 

У фајлу се уносе само вредности за зоне накнаде које ЈЛС има дефинисане на својој 

територији. Остале вредности остају 0. Није дозвољено мењати колону id. 

Именовање фајла: 
 
Фајл се именује у складу са конвенцијом: 

jls_<naziv_jls>_iznosi_naknada.xlsx 

Уз припремљене ГИС формате као саставни елемент дигиталног Зонинг плана, 
приликом прослеђивања ових докумената Агенцији, овај Excel (.xlsx) фајл је саставни 
елемент дигиталног Зонинг плана. 

У накнадној обради нацртане зоне накнаде ЈЛС ће бити упарене са XLS шифарником и 
на овај начин ће се знати износи накнада за сваку просторно дефинисану зону накнаде.  

10.2 Очекивани резултати 

● Подаци о зонама накнаде унети су  у складу са стандардизованом структуром; 

● сви полигони имају попуњене вредности за обавезна поља; 

● сви полигони имају добар координатни систем; и 

● Слој зона накнада је спреман за достављање Агенцији. 

11. ПРИПРЕМНЕ РАДЊЕ ЗА УВОЗ ДИГИТАЛНОГ 

ЗОНИНГ ПЛАНА У ПОРТАЛ ЗА РАЗМЕНУ ПОДАТАКА 
Након успешне припреме и чувања података о зонама намене и зонама накнаде, 

последњи корак представља њихова достава кроз Платформу за размену података 

(QNAP). 
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11.1 Начин прослеђивања дигиталног Зонинг плана: 

Приступањем на линк интернет странице: https://svojnasvome.eobuke.rs/login, односно 

приступањем на Апликацију за сертификацију, након што извршите валидацију ваших 

контакт података (Поглавље 5.1), могуће је приступити Платформи за размену података 

(QNAP) (Поглавље: 4.5) на којој ће бити понуђени јединствени фолдери за сваку од 

јединица локалних самоуправа за унос слојева зона намене и зона накнада. Одабиром 

вашег фолдера, приложићете све припремљене фајлове. Након што извршите овај 

поступак, Агенцију ћете обавестити путем имејла са обавештењем следеће садржине: 

1. Списак планских докумената, односно графичких прилога које сте доставили, које 

сте референце и чије сте податке користили; 

2. Контакт лица које је овлашћено, односно овлашћених лица испред јединице 

локалне самоуправе и која гарантују веродостојност и валидност ових докумената; и 

3. Техничке податке: Координатни систем, појединости у смислу припреме ГИС 

формата и слично. 

11.2 Контрола техничке исправности достављених података: 

Агенција врши контролу техничке исправности података које јединице локалне 

самоуправе доставе на Платформи за размену података (QNAS) (Поглавље 5 овог 

упутства). Контрола техничке исправности обухвата следеће податке: 

1. Провера исправности приложеног ГИС формата (да ли је векторски ГИС формат 

исправног карактера, провера читљивости унетих полигона и унетих података 

атрибута; 

2. Провера приложених ГИС докумената на дигиталној ГИС платформи - провера на 

“лицу места”; 

3. Провера достављених података који чине саставни елемент зона накнаде. 

11.3 Очекивани резултат 

Резултат ове процедуре је: 

1. стандардизован GPKG фајл који садржи: 

● Попуњен слој зона јавне намене  

● Попуњен слој зона накнаде, 

2.  попуњен стандардизовани XLS документ са износом накнада за сваку од зона 
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12. ОПШТЕ ИНФОРМАЦИЈЕ 

12.1 Корисне информације – смернице ка важним интернет 

страницама: 

У циљу поступања у складу са одредбама овог Упутства, могуће је извршити 

инсталацију следећих софтвера: 

● AutoCAD / AutoCAD 3D Max: https://www.autodesk.com/products/autocad 

● QGIS: https://qgis.org/ 

Линк ка Апликацији за сертификацију: https://svojnasvome.eobuke.rs/  

Линк ка Дигиталној ГИС платформи: https://mapp.rgz.gov.rs/Apps/?tenant=zoniranje 

Линк ка Платформи за размену података: https://q1.rgz.gov.rs/cgi-bin/ 

https://www.autodesk.com/products/autocad
https://qgis.org/
https://svojnasvome.eobuke.rs/
https://q1.rgz.gov.rs/cgi-bin/

